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Introduction 

Important information about this guide 
The Send-it 3.x Practical Guide documents the Send-it software when installed and used 
without the PrePage-it Web module. This is typically the case when Send-it is integrated into a 
NEWSflo installation, although it may also be incorporated into other workflows where PrePage-it 
Web is not installed. 

If you need information about Send-it when it is installed and used together with the PrePage-it 
Web module (which is typically the case with workflow products such as PrePage-it ’09), please 
consult the separate PrePage-it Web QuickStart Guide. 

Note that this guide is based on Send-it v.3.0.1.0. 

What is Send-it? 
Send-it is an optional module that may be added to an existing Polkadots workflow such as 
NEWSflo. Send-it is designed for remote job submission, e-proofing and job approval. It gives 
external customers or suppliers the ability to submit files to your RIP for preflighting and 
RIPping. It also allows them to remotely softproof and approve/reject their own jobs. Once they 
approve a job, it will appear in your workflow just like jobs that your own operators RIP 
internally at your company. Once jobs have been approved by external customers, you may take 
any necessary actions to complete and output the job. In a typical NEWSflo setup, for example, 
you would set up your publications in whatever way you are accustomed to doing and the 
remotely submitted pages will then be paired up and output. 

Send-it can be accessed by any internal operator who has a Send-it user account. All jobs 
submitted by external customers via Send-it will be visible to internal operators, who will be able 
to softproof them. In addition, operators can also verify status information about submitted jobs, 
such as: who submitted it? when? in which queue? who approved or deleted a job? etc. 
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How to use this guide 
 

Chapter 1 – Send-it for external customers / suppliers (p.5) - contains basic, practical 
explanations and procedures for external customers / suppliers, namely: 

• how to submit jobs via Send-it 

• how to softproof them, and 

• how to approve/reject jobs 
External customers/suppliers log on to Send-it with Super-User or User accounts. Note that 
virtually everything that an external customer/supplier can do in Send-it, an internal operator also 
has the authority to do. Therefore most of the information in this chapter applies both to 
external customers/suppliers as well as internal operators. 

 

Chapter 2 – Send-it for internal operators (p.20) – contains information pertaining specifically to 
internal operators, that is, operations which external customers/suppliers are not authorized to 
do. This includes: 

• verifying the status of jobs submitted by any user (and verifying accompanying softproofs 
if necessary) 

• creating Send-it accounts for external customers/suppliers 
As mentioned above, since internal employees log on to Send-it with an Operator account, they 
automatically have the authority to do virtually anything an external customer/supplier can do. 

Technical information 
Send-it works as a Client-Server application. The Server application is installed on the server 
machine where PrePage-it is installed. Send-it Clients can then be launched from any web 
browser on any machine, both internally at the company and externally at any of the company’s 
customers/suppliers. 

When Send-it is coupled with NEWSflo (for newspaper production), the workflow can be 
configured so that jobs submitted via Send-it automatically appear in the PrePage-it Client. A 
detailed technical explanation of this setup can be found in the tech note How to set up Send-it with 
NEWSflo. 



  S E N D - I T  3 . X  P R A C T I C A L  G U I D E  

-5- 

Chapter 1 - 
Send-it for external customers / suppliers 

This chapter contains basic, practical explanations and procedures necessary for external 
customers / suppliers to work with Send-it, as summarized in the list below. Since an internal 
operator has the authority to do virtually everything that an external customer/supplier can do in 
Send-it, most of the information in this chapter also applies to internal operators. 

External customers/suppliers log on to Send-it with Super-User or User accounts (see User 
Accounts on p. 22 for more information about Send-it accounts). 

Reminder 

The features and options you see in the Send-it interface depend on (i) which Send-it 
options were purchased and (ii) which user account you are currently logged on with. 
Therefore your Send-it interface may not show all options/features mentioned in this 
guide. For more information, see User Accounts on p. 22 and View-it on p.28. 

What can external customers / suppliers do with Send-it? 
Send-it allows external customers / suppliers to: 

• submit jobs to be pre-flighted and RIPped 

• see list of RIPped jobs 

• view softproofs: low-res Previews, PDF softproofs (optional), and View-it hi-res softproofs 
(optional) 

• approve/flush pages & jobs 

• write and read annotation comments in a View-it softproof 

• receive e-mail notifications of events (e.g. approved jobs, errors) 

• more (depending on user account permissions and purchased options) 
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Launching Send-it 

Note 

Send-it Clients can be launched from any workstation equipped with one of the 
following operating systems: Win XP Pro (or higher), Mac OS 10.4 (or higher). 

Send-it  Clients can be opened in any web browser on any workstation by: 

1. Typing the IP address or URL of the Send-it Server. 
2. Logging on with your Send-it Login username/password. 

 
 

IP address 

An external customer/supplier must use the external, public IP address or URL of the Send-it 
Server (add port number if other than port 80). 

Internal operators should use the internal, private IP address or URL of the Send-it Server (add 
port number if other than port 80). 

Web browsers 

• Firefox 2 or 3 (Mac or PC) 

• Internet Explorer 7 (PC) 

type IP address or 
URL of the Send-it 
Server 

type your Login username 
and password 
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• Safari v.3 (Mac OS 10.4 or higher) 
 

Browser tips 

• it is recommended to use recent versions of web browsers, as listed in the previous section 

• if you will be doing file uploads via the Java Applet, you will need to install Java on each 
workstation where you will be using Send-it  

• avoid adding extra toolbars and add-ons (e.g. Google toolbar, etc.) 

• pop-up blockers can prevent some Send-it windows from being displayed 
 

How to create a job 
The procedure below describes how to create a job with Send-it, including how to upload, 
softproof, and approve/reject job files. 

Note 

If you are using the PrePage-it Upload or PrePage-it Printer to submit jobs, refer to the 
section Printing tools on p. 14 to know how to use these tools. 

Create a job name 

1. To create a new job name/folder, click the "+" to the left of the Jobs link and type a name 
for the new job. 
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  or    
 

 
 

Tip 

If an operator creates a job and they want that job to be visible to a particular 
customer, then select that customer as the Owner. In addition, you can make a job 
visible to every user under the Owner by checking the box Make this job visible for the 
entire group. 

 

Single Pages 

2. Make sure you are in Pages mode (Operators only). 

  or    
 

3. Select the required job folder from the Jobs list. 

Give a job name
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or 

 
 

4. Upload single pages for preflight and RIPping from the Upload tab. 
Follow the instructions provided. 

 
 

Reminder 

Uploads via the Java applet requires Java to be installed on the Send-it Client 
workstation. 

a. Select File (Browse or Java applet) 

b. Select a PAGES Queue 

d. Click Send-it button 
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5. Softproof single pages from the Jobs tab in one of the following formats: 
a low-res Preview 
b med-res PDF (optional - click PDF icon  if available) 
c hi-res View-it softproof (optional – click View-it link if available) 
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low-res Preview 

Med-Res PDF softproof 
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Note 

Med-Res PDF proofing files are available for softproofing from the PDF icon on the 
condition that they have been already produced by the PrePage-it queue during 
RIPping. 

6. Approve pages / jobs in the following way: 

Hi-Res View-it softproof 
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a If you are set up with page approval, then select one or more pages and click the 
Approve button. 
  or    

b If you are set up with job approval, then when all pages are ok, Approve the whole 
job. 

 
 

Note 

Send-it approval may be configured on a per-job or per-page basis. If you are set up 
with page approval, then rather than approving the entire job, you must approve one 
page at a time. You will not have the option of approving the entire job as shown in 
the figure above. 

Tip 

As an alternative, a page may also be approved from within the View-it softproof 
window. 

Important 

When the terms Flush / Reject / Delete are used in reference to a page or job, they all 
have the same meaning i.e. the RIPped files will actually be deleted from the hard 
disk. 

Approve page(s)

Approve 
entire job 
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Printing tools 
Send-it allows you to submit jobs via the Upload tab, either by clicking the Browse button or with 
the Java Applet. In addition to this, it is also possible to submit jobs without logging on to the 
Send-it Client. This can be done via two separate tools called PrePage-it Upload and PrePage-it Printer. 
PrePage-it Upload allows you to submit PS or PDF jobs to RIP queues by dragging and dropping 
them to the PrePage-it Upload window. The PrePage-it Printer tool creates a printer called 
ToPrePageitServer, which you can use to print jobs to RIP queues from any application. These 
tools can be installed and used on any Mac or PC workstation. They provide more convenient 
ways of submitting jobs and are explained in more detail in the following sections. 

Note 

The PrePage-it Upload and PrePage-it Printer tools can be used on Windows XP Pro (or 
higher) and Mac OS 10.4 (or higher). 

Installing PrePage-it Upload / Printer 

The PrePage-it Upload Setup is an installer which installs both the PrePage-it Upload and PrePage-it Printer 
tools. It must be installed on each workstation where these tools will be used. There are two 
installers – one for Mac (zip) and one for PC (exe). 

  

These installers can be downloaded by clicking the link Upload Client in the Send-it Upload tab. 

 

 

To install, launch the PrePage-it Upload Setup and follow the instructions provided. 
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When prompted with the following window, you should provide the Send-it Host information i.e. 
the IP address or URL of the server machine. 

 

Note 

For external customers/suppliers who install PrePage-it Upload, the Send-it Host 
information must be the external, public IP address or URL of the server machine. 
Internal operators must provide the internal, private IP address or URL of the 
Send-it server. 

The Scratch Folder, Port and Printer Service settings can usually be left at their defaults. If you need 
to specify a custom port or change one of the settings, you may do so at this point. 

After a successful installation, you will see two items added: the PrePage-it Upload application (on 
the Windows desktop or the Mac Applications folder) and a printer called ToPrePageitServer. 
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PrePage-it Upload and PrePage-it Printer 

The following procedure outlines how to submit jobs via the PrePage-it Upload or PrePage Printer. 
This single procedure describes both tools. 

1. Launch the PrePage-it Upload application and log in with your Send-it account. If necessary, 
click the Server arrow and select your server. 

 
 

2. In the PrePage-it Upload window shown below, specify the Job and Queue where you want 
to submit a file. If necessary, create a new Job folder by clicking File > Add Job. 
Note that what you select here applies whether you drag and drop files or print them 
using the PrePage-it Printer. 
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Tip 

The PrePage-it Upload application window should always be kept open when you are 
submitting jobs, whether by drag n drop or by printing. 

 

3. Drag and drop: If you want to drag and drop PS or PDF files, drag them unto the 
PrePage-it Upload window. 

 

-or- 

 

Print: To print a file from an application, select the ToPrePageitServer printer when printing 
from your application. 

Specify Job 
folder where file 
will be placed 

Drag n drop jobs 

Specify Queue 
where file will be 
RIPped 
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Tip 

To automatically open the Send-it window, click the Show Web Entry button. 

View modes 

 

Jobs can be viewed in one of the three following modes, as selected in the View By dropdown 
menu (shown above): 

• View by Icon 
• View by List 
• View by Status (only internal operators have access to this view) 

 

View by Icon shows the thumbnail preview of pages. 

View by List displays information about pages without showing any preview. Information includes 
original filename and size. This view allows you to list many more pages at once. 

View by Status displays the Upload History and Operation History of the selected job. 

Job Filter 
The Job Filter helps you to find a job quickly when your job list has become too long to scan 
through quickly. 

Print using 
ToPrePageitServer 
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In the Filter box found inside the Jobs tab, you can filter out the job list by typing all or part of a 
job name. After typing the filter characters, press Enter or click the Arrow button. 

It will filter the job list down to only those jobs containing the specified filter characters 
anywhere in the job name. 

To return to the full job list, empty the Filter box and press Enter. 

 

a. type all or part of job’s 
filename 

b. click Arrow button or 
press Enter key 



  S E N D - I T  3 . X  P R A C T I C A L  G U I D E  

-20- 

Chapter 2 - 
Send-it for internal operators 

This chapter contains explanations and procedures which internal operators should know 
regarding Send-it. This includes: 

• verifying the status of jobs submitted by any user (and verifying accompanying softproofs 
if necessary) 

• creating Send-it accounts for external customers/suppliers 
Internal operators log on to Send-it with Operator accounts (see User Accounts on p. 22 for more 
information about Send-it accounts). 

Reminder 

Most of the information contained in Chapter 1 (starting on p.5) applies both to 
external customers/suppliers as well as internal operators, therefore it is 
recommended reading for operators. 

What can internal operators do with Send-it? 
Send-it allows internal operators to do virtually everything external customers/suppliers can do, 
plus some additional functions, as listed below: 

• submit jobs to be pre-flighted and RIPped 

• see Upload History (list of submitted files / users / dates / queues) 

• see Operation History (list of actions executed by users e.g. approval, deletion, overwrite a 
page) 

• see list of RIPped jobs 

• view softproofs: low-res Previews, PDF softproofs (optional), and View-it hi-res softproofs 
(optional) 

• approve/flush pages & jobs 
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• write and read annotation comments in a View-it softproof 

• create user accounts for external customers / suppliers 

• receive e-mail notifications of events (e.g. approved jobs, errors) 

Software updates 
After the initial installation, you may at some point in the future be supplied with a Send-it 
software update. When applying an update to Send-it keep the following in mind: 

• the update must always be executed on the server machine where the Send-it Server and 
PrePage-it Viewer / RIP are installed, not on an operator’s workstation 

• you can use a Send-it v3.x updater to update from a Send-it v2.2, but not from Send-it 
v2.1 

Queue types 
Send-it lists two types of queues: Pages (Normalize) and Upload Only: 

 

Pages queues 

 

These queues preflight and process single-pages, RIPping them into rasterized, contone pages. 
Each RIPped page includes: 

• hi-res separations (for output) 

• med-res component (for proofing) 

• low-res page (for imposition or page pairing / containing OPI link to hi-res) 
 

Upload Only 
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The Upload Only queue provides a way of exchanging files between Users/Super-users (external 
suppliers/customers) and Operators (internal company). Similar to an FTP Client, it can be used 
to upload and download files between a company and its suppliers. Anyone with a Send-it 
account can upload any type of file. This means that not only can users transfer PS or PDF jobs, 
but also files that cannot be sent directly to a RIP e.g. native Quark/InDesign/Text files. 

Before a file is submitted to the Upload Only queue, you still need to select a Job folder, as is the 
case for all job submissions. 

 

When a job is submitted to the Upload Only queue, it will appear in the File Upload History list with 
2 options: Flush (red “x”) or Download (see screenshot above): 

• clicking Download allows you to save the file on your hard disk 

• the file will remain in the File Upload History until it is flushed (i.e. deleted) by clicking 
on the red “x” 

 

Tip 

You can prevent a customer/supplier from submitting jobs directly to a RIP queue 
by hiding all queues except the Upload Only queue. 

User Accounts 
General info 

Send-it has 4 levels or “classes” of users: Administrator, Operator, Super-User and User. 
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From highest to lowest rights/permissions: 

1. Administrator 

2. Operator 

3. Super-User 

4. User 

 

Levels 1 and 2 (Administrator and Operators) are internal employees of the company who 
purchased Send-it. 

Levels 3 and 4 (Super-Users and Users) are their customers/suppliers. 

Note 

For more information on setting up your customers, refer to the section How to set 
up your external customers/ suppliers to use Send-it on p.25. 

Note that all levels of users can: 

• create jobs 

• submit files to Pages and Upload Only queues 
 

Administrator 

There is one Send-it Administrator. The administrator can: 

• create any type of user account i.e. Operator/Super-User/User 

• set general Send-it preferences in the Settings tab: 

• visibility of queues (for all users) 

• e-mail (staff) notifications 

• server configuration 

• list/softproof/approve/reject all jobs 

• do everything Operators/Super-Users/Users can do 
 

User levels for internal 
employees. 

User levels for external 
customers / suppliers. 
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Note 

Administrator configuration should only be performed by personnel who are 
technically trained with Send-it and Polkadots workflows in general. 

 

Operators 

Operators are company employees. They can: 

• list/softproof/approve/reject all jobs 

• do virtually everything Super-Users/Users can do 

• create Super-User accounts 

• decide which queues a Super-User can see (Queue Visibility) 

• decide if a Super-User has the power to change the status of approved/rejected jobs 
 

Super-Users 

A Super-User works for a supplier or client of the main company. In addition to doing what any 
User can do, Super-Users can also manage Send-it user accounts for their own employees (i.e. Users). 

They can: 

• create Users 

• decide if a User is allowed to accept/reject jobs or only to view them 

• list/softproof/approve/reject jobs from their own user group (i.e. jobs submitted by 
themselves or a User they have created) 

• list and submit files to Pages and Upload Only queues (except hidden queues) 
 

Users 

Users also work for a supplier or client of the main company. However, unlike the Super-User, they 
cannot manage user accounts. 

They can: 

• list/softproof only their own jobs 
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• approve/reject jobs (if authorized by Super-User or Administrator) 

• list and submit files to Pages queues and Upload Only queues (except hidden queues) 
 

Tip 

To see the Send-it interface that your customers/suppliers are using when they 
submit jobs to you, create a Super-User or User account and log on with that account. 

 

User groups 

A User Group refers to a “user” and all others below him in the user hierarchy, as illustrated in the 
examples below. 

 

 

How to set up your external customers/ suppliers to use 
Send-it 
The following is a summary of the main points regarding (i) how to set up Send-it for your 
customers/suppliers and (ii) some specifics on how they can work with it: 

• each one of your customers/suppliers should be assigned at least one Super-User account 

• the Super-User can manage user accounts for his own company, that is he can create User 
accounts for any other employee of his company who needs to submit jobs, softproof 
them, etc. 

• if you prefer, the Administrator can create User accounts for a customer/supplier rather than 
letting the Super-User do this 

User Group medjournal consists of: 
-medjournal (super-user) 
-Larry (user) 
-Dr Smith (user) 

User Group Mary consists of: 
-Mary (operator) 
-abpharma (super-user) 
-acmeprint (super-user) 
-Pierre (user) 
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• all Super-Users and Users will be able to log on to Send-it from their own workstation by (i) 
typing your Send-it Server’s External, Public IP Address or URL into any web browser and (ii) 
logging on with their Login name and Password 

 
 

Tip 

If you don’t know the external, public IP address of your Send-it Server, open a web 
browser directly on the server machine and go to the following web site: 
http://www.whatismyip.com/. If in doubt, please refer to your network 
administrator. 

• the Send-it interface for external customers is similar to internal operators, except that the 
Send-it logo is shown in the top left corner and Super-Users and Users have limited access 
and functionality 

type Public IP 
Address or URL 
of  the Send-it 
Server 

type Login 
Username and 
Password 

http://www.whatismyip.com/
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• Super-Users and Users will be able to submit pages to your PrePage-it/RIP queues, softproof 
them and approve/reject them, just like your own internal operators do 

Tip 

If you wish to prevent some Super-Users and Users from submitting jobs directly into a 
PrePage-it queue, you can hide the queues and ask them to submit via the Upload 
Only queue (see p.21 for details). 

• internal operators will also be able to softproof and approve/reject jobs that have been 
submitted by external customers/suppliers 

• annotation comments can be written by anyone directly in a View-it softproof and will be 
visible to everyone 

• once a job is approved, internal operators can take over and complete the job in whatever 
way they are accustomed to doing, depending on the workflow setup: 

• in a NEWSflo setup: create and enable a publication in the Publication Planner, then let 
NEWSflo pair the pages together 
or 

• in a commerical setup: impose the low-res pages in your usual imposition application, 
then print/resend your imposition back to PrePage-it in order to create the 1-bit 
TIFFs and output the plates 
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View-it 
View-it is an optional module that may be added to your workflow. 

View-it is a high-resolution softproof of the RIPped data, showing the actual rasterized job as it 
will be printed on the plate. The proof is shown in a web browser and includes a number of tools 
for easy viewing (zooming, rotating), color information, approval/rejection, measuring (angles, 
distance) and annotation comments. Colors can be viewed individually or together. 

The View-it module integrates seamlessly into the Send-it interface. The View-it softproof is 
mentioned in various parts of this manual, most notably in the section How to create a job, 
starting on p.7. 

Troubleshooting & Tips 
This section includes some basic troubleshooting guidelines and tips in a question and answer 
format. 

 

Q: If portions of the Send-it interface are displayed incorrectly or missing? 

A1: Try to Reload/Refresh the web page. Web browsers generally have a Reload or Refresh 
command (see figure below). 

A2: As a last resort, try erasing the web browser’s cache and then Reload/Refresh the web page. 
Try this if you notice a display problem occurring after a software update. 

To do so: 

• Firefox: click Tools > Clear Private Data 

• Internet Explorer: click Tools > Internet Options > Browsing History > Delete 

• Safari: click Safari > Reset Safari 
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Refresh / Reload the web page 

F
I
R
E
F
O
X 

 

 

S
A
F
A
R
I 

 

 

I
N
T
E
R
N
E
T 

 
E
X
P
L
O
R
E
R 

 

Reload button or 
CTRL+R (PC)or 
Command+R (Mac)

Refresh or F5 

Reload button or 
Command+R (Mac)
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Q: If dragging & dropping a file using the Java applet causes problems? 

A1: Make sure that Java is installed on every Send-it Client workstation where you will be doing 
file uploads via the Java Applet.  

A2: Uninstall Java, then download and install the Java version: Java v6r3. 

A3: Click the link Revert to original upload, then use the Browse button to upload files or try the 
PrePage-it Upload utility. 

 

 

Q: Some windows are not opening when you click a link in the Send-it Client? 

A1: Make sure you are using recent versions of web browsers. 

A2: Pop-up blockers can prevent some Send-it windows from being displayed – try de-activating 
them. 

A3: Avoid adding extra toolbars and add-ons (e.g. Google toolbar, etc.). 

 

Q: In a workflow which includes a dedicated Send-it Server and the PrePage-it Client: if 2 customers submit jobs 
with identical filenames, the second job may show up in the same PrePage-it Client folder as the first job. 

A: If this occurs, you should do the following in the PrePage-it Client: 

1. Rename the files from the second job. 
2. If necessary, manually create a new job folder for the second job. 
3. Now drag & drop the RIPped pages belonging the second job over to the correct folder. 

 

 



 
 
 

 
 
 

 

 

 
Polkadots Software Inc. 

2501 Dollard 
Montreal, Qc, H8N 1S2, Canada 

Phone (514) 595-6866 
Fax (514) 595-6012 

http://www.polkadots.ca/ 
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